
1
Getting to Know the Work Area

In This Chapter
� Understanding the Elements workspace

� Changing workspace views

� Working with the Photo Bin

� Using the Undo History palette

� Accessing Help documents

� Using keyboard shortcuts

In the Elements work areas, you find quite a collection of tools, palettes,
buttons, and options. Just a quick glance at the Elements workspace when

you enter Full Edit mode shows you some of the power that Elements offers
with just a click of your mouse. With all the possibilities, the Elements work-
space can be intimidating. To ease your introduction to the many
options for editing your pictures, we break them down for you
in this chapter.

Elements has several work areas, and we start off by
introducing you to the one you’ll likely use most
often, Full Edit mode. In this mode, you can be 
creative with all the tools and features Photoshop
Elements is known for, such as filters, drawing tools,
layers, and more. We then introduce other work
areas and tools you may not be as familiar with —
Quick Fix mode for making common corrections to
photos, Creation Setup mode for collecting your photos
into creations such as calendars, and the Photo Bin for
navigating among all your open images.

Before you start working in Elements, you’ll find it helpful to
know how to undo edits so that you can start over easily and find addi-
tional sources of help within Elements. We also explain one of the handiest
ways to select tools and enter common commands: keyboard shortcuts.
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10 Part I: Getting Started 

Elements 5 also has the Organizer, a powerful tool for acquiring your images
and keeping them organized. The Organizer includes features that help you
view and search for images, too. We introduce the Organizer in Part II.

Getting Around in Full Edit Mode
Full Edit mode offers bundles of tools for editing your images, from correc-
tion tools for fixing color and clarity to filters, layers, and more for creating
entirely original images either from existing photos or from scratch. But all
these tools also make Full Edit mode complex.

Figure 1-1 shows Elements in Full Edit mode, highlighting all the tools and fea-
tures we discuss in this section.

Jumping to Full Edit mode
You can move into Full Edit mode in a couple of ways:

� From the initial Welcome screen, click Edit and Enhance Photos and
open a photo. Your Elements window appears in Full Edit mode, as
shown in Figure 1-1.

� From the Organizer, click Edit on the Shortcuts bar and choose Go to
Full Edit from the drop-down menu.

Examining the Image window
Not surprisingly, the Image window’s tools and features are most useful when
an image is open in the window. To get an image into the image window (refer
to Figure 1-1), follow these steps:

1. Click the Open tool on the Shortcuts bar.

The standard Open dialog box appears. It works like any ordinary Open
dialog box you find in other applications.

2. Move around your hard drive by using methods you know to open
folders and select a picture.

If you haven’t yet downloaded digital camera images or acquired scanned
photos and want an image to experiment with, you can use an image
found in your My Pictures folder that was installed with Windows or
select a photo on the Mac.

3. After selecting a picture, click Open.

The photo opens in a new image window in Elements.
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Figure 1-1: The Photoshop Elements workspace is shown when you open a file in Full Edit mode.

You can open as many image windows in Elements as your computer
memory can handle. As each new file is opened, a thumbnail image is added
to the Photo Bin at the bottom of the screen (see Figure 1-1), and the image
windows are stacked, with the current active image in the topmost window.
To bring another open file to the foreground and make it active, click the
respective thumbnail in the Photo Bin.

Full Edit Quick Fix Shortcuts bar Search Help topic

Menu barTitle bar

Close

Maximize mode

Maximize
Automatically

cascade windows Minimize

Automatically
tile windows

Photo binTools palette Image window Palette bin
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12 Part I: Getting Started 

Here’s a quick look at important
items in the image window, shown
in Figure 1-2:

� Scroll bars become active
when you zoom in on an image.
You can click the scroll arrows,
move the Scroll bar, or grab the
Hand tool in the Tools palette
and drag within the window to
move the image around.

� The Magnification box shows
you at a glance how much you
zoom in or out.

� The Information box shows you
a readout for a particular tidbit
of information. You can choose
what information you want to
see in this area by choosing one
of the options from the pop-up
menu, which we discuss in
more detail later in this section.

When you’re working on an image in
Elements, you always want to know the physi-
cal image size, the image resolution, and the
color mode. (These terms are explained in
more detail in Chapters 3 and 4.) Regardless
of which menu option you choose from the
status bar, you can get a quick glimpse at
these essential stats by clicking the
Information box, which displays a pop-up
menu like the one shown in Figure 1-3.

� The Size box enables you to resize the window. Move the cursor to the
box, and a diagonal line with two opposing arrows appears. When the
cursor changes, drag in or out to size the window smaller or larger.

You can also resize the window by dragging any of the other corners in
or out.

� Click the Minimize button (the _ button in the upper-right corner of the
image window), and the window hides from view. It’s still open; you just
click the image in the Photo Bin to maximize the window. On the Mac,
it’s the yellow minus (–) button in the top-left corner.

� If you click the Maximize button (the button with the box-shaped icon),
the Title bar shown at the top of the window disappears and provides
you with a little more room for viewing images in the window. On the
Mac, it’s the green plus sign (+) in the top-left corner.

Image area Title bar

Magnification box

Information box Size box

Figure 1-2: The image window displays an
open file within the Elements workspace.

Figure 1-3: Click the readout on
the status bar, and a pop-up
menu shows you important
information about your file.
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� You can click the Close button (it’s shaped like an X) to close the active
image window and keep Elements open. Alternatively, you can use the
keyboard shortcut Ctrl+W/Ô+W or the menu command File➪Close to
close the active window. On the Mac, it’s the red button in the top-left
corner.

Now that you’re familiar with the
overall image window, we want to
introduce you to the Information
box’s pop-up menu, which enables
you to choose the type of informa-
tion you want to view in the
Information box. Click the right-
pointing arrow to open the menu, as
shown in Figure 1-4.

Here’s the lowdown on the options
you find on the pop-up menu:

� Document Sizes: Shows you the
saved file size.

� Document Profile: Shows
you the color profile used with
the file.

� Document Dimensions: Shows
you the physical size in your default unit of measure, such as inches.

� Scratch Sizes: As shown in Figure 1-4, displays the amount of memory 
on your hard drive that’s consumed by all documents open in Elements.
For example, 20M/200M indicates that the open documents consume
20 megabytes and that a total of 200 megabytes are available for Elements
to edit your images. As you add more content to a file, such as new layers,
the first figure grows while the second figure remains static.

� Efficiency: Indicates how many operations you’re performing in RAM as
opposed to using your scratch disk. When the number is 100%, you’re
working in RAM. When the number drops below 100%, you’re using the
scratch disk. If you continually work below 100%, it’s a good indication
that you need to buy more RAM to increase your efficiency.

� Timing: Indicates the time it took to complete the last operation.

� Current Tool: Shows the name of the tool selected from the Tools
palette.

Don’t worry about trying to understand all these terms. The important thing
to know is that you can visit the pop-up menu and change the items at will
during your editing sessions.

13Chapter 1: Getting to Know the Work Area

Click here to open pop-up menu

Figure 1-4: From the pop-up menu on the
status bar, you select commands that provide
information about your file.
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Moving through the menu bar
Like just about every program you launch in Windows or on the Mac, Elements
supports drop-down menus. The menus are logically constructed and identi-
fied to provide commands for working with your pictures (commands that
you don’t find supported in tools and on palettes). A quick glimpse at the
menu names gives you a hint of what might be contained in a given menu list.

The ten different menus are described in this list:

� File menu: Just as you might suspect, the File menu contains commands
for working with your picture as a file. You find commands in the menu
list for saving, opening, processing, importing, exporting, and printing.
We cover saving files in Chapter 3 and printing or exporting for other
output in Part V.

� Edit menu: As you might guess, the old-fashioned Copy, Cut, and Paste
commands are located here. Additionally, you have some important file
settings commands on the menu, including preferences, which we cover
in more detail in Chapter 2.

� Image menu: You find yourself using the Image menu when you want to
effect changes to the entire image, such as changing a color mode or
cropping, rotating, and resizing the image. For details about sizing and
color modes, check out Chapter 3. For more about cropping and rotating
images, flip to Chapter 9.

� Enhance menu: Just the name of this menu should tell you what com-
mands to expect here. This is where you go to change the appearance of
an image, such as changing its brightness and contrast, adjusting its
color and lighting, and doing some other smart fix-up work to improve
its appearance. On the Enhance➪Adjust Color submenu, you find a
new adjustment introduced in Elements 5: Color Curves. Look to
Chapter 10 for some detail on using this new command. In Chapters 9
and 10, you find out how to use correction tools so that your images
look their best.

� Layer menu: As we describe in great detail in Chapter 8 (a whole chap-
ter just about layers), most kinds of editing you do in Elements are best
handled by using layers. Elements neatly tucks away all the relevant
commands associated with working in layers right here.

� Select menu: Of just about equal importance to layers are selections.
Whereas the Image menu contains commands that are applied to the
entire image, you can edit isolated areas of an image by using the com-
mands on the Select menu. To isolate an area, you need to create a 
selection, as we explain in Chapter 7. This menu contains commands to
help you with all the essential tasks related to working with selections.
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� Filter menu: The Filter menu is where you leave the world of photogra-
phy and explore the world of a fine artist. With tons of different filter
commands, you can create some extraordinary effects. Find out all
about filters in Chapter 11.

� View menu: Zooming in and out of images, turning on a grid, exposing
horizontal and vertical rulers, adding annotations, and checking out the
print size of your pictures are handled on the View menu. Chapter 5
unearths secrets of the Zoom tool, rulers, and more.

� Window menu: Elements supports a number of different palettes, as we
explain later in this chapter. Elements has so many palettes that keeping
them all open at one time is impractical. Thanks to the Window menu, you
can easily view and hide palettes, reopen the Welcome window, tile and
cascade open windows, and bring inactive windows to the foreground.

� Help menu: We hope that you get all the help you need right here in this
book; but just in case we miss something (or your neighbor has bor-
rowed it, fine book that it is), you have some interactive help, right at
your mouse-tip, on the Help menu. The menu also offers links to the
Adobe Web site for more information and a little assistance, courtesy of
the tutorials accessible from this menu. (Find a little more detail about
accessing help later in this chapter.)

Uncovering the context menus
Context menus are common to many programs, and Photoshop Elements is no
exception. They’re those little menus that appear when you right-click, offer-
ing commands and tools related to whatever area or tool you right-clicked.

The context menus are your solution when you may be in doubt about 
where to find a command on a menu. You just right-click an item, and a 
pop-up menu opens. As you become familiar with 
Photoshop Elements and struggle to find a menu 
command, always try to first open a context 
menu and look for the command you want in the 
menu list.

Because context menus provide commands 
respective to the tool you’re using, the menu 
commands change according to what tool or 
feature you’re using at the moment you open a 
context menu. For example, in Figure 1-5, you can 
see the context menu that appears after we cre-
ate a selection marquee and right-click that 
marquee in the Image window. Notice that the 
commands are all related to selections.

15Chapter 1: Getting to Know the Work Area

Figure 1-5: A context menu for
selections.
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16 Part I: Getting Started 

Using the Tools palette
Elements provides a good number of palettes for
different purposes. The one that you’ll find you
use most is the Tools palette. In palette hierarchy
terms, you typically first click a tool in the Tools
palette and then use another palette for additional
tool options or use the Options bar for fine-tuning
your tool instruments. More often than not, click-
ing a tool in the Tools palette is your first step in
most editing sessions.

Tools can be easily accessed in Elements by press-
ing shortcut keys on your keyboard. For a quick
glance at the Tools palette and the keystrokes
needed to access the tools, look over Figure 1-6.

If you accidentally press the Tab key on your key-
board, the Tools palette hides from view. Press
Tab again and the Tools palette reappears.

Notice in the Tools palette that several tools
appear with a tiny arrow pointing right and down-
ward in the lower-right corner of each tool. When-
ever you see this arrowhead, remember that more
tools are nested within that tool group. Click a tool
with an arrowhead and hold down the mouse
button. A pop-up toolbar opens, as shown in
Figure 1-7, and offers you more tool selections
within that group.

To select tools within a tool group by using key-
strokes, press the Shift key and strike the respective
key (shown in Figure 1-6) to access the tool. Keep
the Shift key down and repeatedly press the short-
cut key to scroll through all tools in a given group.

The shortcuts work for you at all times except
when you’re typing text. Be certain to click the
Tools palette to select a tool if your 
last edit was made with one of the 
Type tools.

The tools are varied, and you may 
find that you don’t use all the tools
in the Tools palette in your work-
flow. Rather than describe the tool
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Figure 1-6: You access tools
by clicking the tool in the Tools
palette or typing the respective
character on your keyboard.

Figure 1-7: Click and hold the mouse button on
a tool that has a tiny arrowhead, and a pop-up
toolbar opens.
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functions here, we address the tools in the remaining chapters in this book as
they pertain to the respective Elements tasks.

Playing with palettes
Elements provides you with a bunch of palettes that contain settings and
options used to refine the tools you select in the Tools palette and tasks you
perform to edit images. Assume for a moment that you want to let your cre-
ative juices loose and create a Picasso-esque painting — something that you
can easily do in Photoshop Elements.

You first click the Brush tool and then click a color in the Color Swatches
palette. On a new canvas, you begin to paint. When you want to change color,
you click again in the Color Swatches palette on a different color. This kind of
interactivity between the Tools palette and another palette is something you
frequently use in Elements.

Palettes are accessed from either the Palette Bin or the Window menu.
Many options in palettes are intuitive. To become familiar with various
palette options, just poke around a little, and most of the options will
become familiar to you.

Selecting tool options from the Options bar
When you click a tool in the Tools palette, the Options bar offers you choices
specific to a selected tool. Figure 1-8 shows the options available when the
Clone Stamp tool is selected.

Figure 1-8: The Options bar provides attribute choices for a tool selected in the Tools palette.

Juggling all your interface options
With all the settings you can use for any given tool, trying to figure out
exactly where to select an option for the edit you want to make can become
downright frustrating. To help simplify the process of using tools and select-
ing options for the tools, here’s what you might do in your normal workflow:

1. Select a tool in the Tools palette.

Obviously, you need to know what task you want to perform, so select-
ing the proper tool to complete the task is important to know upfront.

2. Take a quick look at the Options bar.

17Chapter 1: Getting to Know the Work Area
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Before moving to other option choices, be certain that you look over the
choices on the Options bar. If you want to use a tool like the Brush tool
or the Clone Stamp tool, perhaps you want to make a decision about
what size brush tip you want to use. This choice is specific to the
selected tool and therefore appears as an Options bar choice.

3. Open a palette for more options.

If you want to use the Brush tool, for example, to apply some color to an
image, after selecting the Brush tip on the Options bar, open the Color
Swatches palette and select a color.

4. Open the More menu.

Maybe the color you want to use doesn’t appear in the Color Swatches
palette. Your next stop is the More menu. By using the menu choices,
you can load different swatch libraries that provide more color options.

Try following the same sequence when you want to edit images in Elements by
first selecting a tool and then checking out the Options bar, opening palettes
related to providing choices for the task at hand, and, finally, clicking the
More button for additional choices in the palettes.

Looking at the Shortcuts bar
You find the Shortcuts bar just above the Options bar and below the Menu bar.
The Shortcuts bar, shown in Figure 1-9, serves two purposes:

� Quick access to common tasks: Tools on the Shortcuts bar are available
for quick access to some of the most common tasks you perform in
Elements.

� Quick access to other Elements functions: Buttons appear for quick
access to other Elements functions that involve organizing documents,
browsing photos, or viewing calendars.

Figure 1-9: In Full Edit mode, the Shortcuts bar provides tools and viewing options.

Full Edit mode Quick Fix mode Print Photo Creations Organizer

Print Online

Share Photos
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Depending on your editing mode, such as Full Edit, Quick Fix, or one of the
other viewing modes, the Shortcuts bar changes to provide different tools
and buttons. Figure 1-9 shows how the Shortcuts bar appears when you view
it in Full Edit mode.

The Shortcuts bar contains tools and buttons grouped as follows:

� The first group includes tools to toggle the Full Edit and Quick Fix
modes. 

� Click the Print tool to print a file.

� The new Print Online icon on the Shortcuts bar is used to open a 
drop-down menu where you make choices for making online orders
for printing photos.

� Click the Share tool to open a drop-down menu where you can make
choices for sharing photos by e-mail, with mobile phones, and with 
several online services.

� Click the Create tool to open a menu where you can choose from a number
of options for making creations such as greeting cards, photo albums, 
CD/DVD labels and jackets, slide shows, photo stamps, calendars,
and more.

� For a quick jump to all the wonderful organizing features provided in
Elements, such as managing photos in collections, sorting photos, cata-
loging photos, tagging photos, and more, click this tool, and you jump to
the Photoshop Elements 5 Organizer.

Changing Workspaces
When you’re in Full Edit mode, discussed in preceding sections, you can
apply any kind of edits to a picture, improve the picture’s appearance, 
and apply all that Elements offers you. This mode is the richest editor in
Elements in terms of accessing all features. Because Elements has so many
different kinds of editing opportunities, the program offers you other work-
space views, tailored to the kinds of tasks people typically want to perform.

Using Quick Fix mode
Quick Fix mode is designed to provide you with just those tools that are
needed to prepare a picture for its intended destination, whether it’s printing,
on-screen viewing, or one of the other organizing items. Use this mode to
make your pictures look good. You don’t find tools for adding text, painting

19Chapter 1: Getting to Know the Work Area
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with brushes, or applying gradients in Quick Fix mode. Rather, what you find
is a completely different set of palettes for balancing contrast and brightness,
lighting, and sharpening, for example. This mode is like having a digital dark-
room on your desktop, where you take care of perfecting an image like you
would in analog photography darkrooms.

To enter Quick Fix mode while you’re in Full Edit mode, click the Quick 
Fix button adjacent to the Shortcuts bar; the view changes, as shown in 
Figure 1-10.

If you want to start up Elements in Quick Fix mode, click the Quick Fix button
on the Welcome screen when you first launch the program.

Figure 1-10: Click Quick Fix in Full Edit mode, and the workspace changes.
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There are several differences between Full Edit mode and Quick Fix mode:

� Completely different sets of palettes are docked in the Palette Bin.
All the palettes in Quick Fix mode are related to adjusting brightness
controls and are designed to improve the overall appearance of your
pictures. In addition, all the Windows menu commands for accessing
palettes are grayed out. While you work in Quick Fix mode, Elements
insists on limiting your use of palettes to just the ones docked in the
Palette Bin. Moreover, you cannot undock palettes from the Palette Bin
by dragging them out, as you can in other modes.

� The Tools palette disappears. Quick Fix mode offers you only these
tools in the Tools palette:

• Zoom

• Hand

• Magic Selection Brush

• Crop

• Red Eye Removal

None of the other Elements tools is accessible while you work in
this mode.

� Multiple viewing options are available.
Notice in Figure 1-10 that you see two views
of the same image. One view displays the
raw, unedited image. The After view shows
you the results of changes you make with
palette options and menu commands.

If you want to return to Full Edit mode, click the
Full Edit button.

Using Creation Wizards
To organize your pictures for display in a variety
of different ways, you begin by accessing a wizard
window respective to a particular creation you
want. From the drop-down menu shown in
Figure 1-11, you make a choice for a particular
creation, and a wizard window opens where you
follow some easy steps to produce creations such
as photo books, album pages, CD/DVD jackets,
and more.

21Chapter 1: Getting to Know the Work Area

Figure 1-11: Click Create in
either Full Edit or Quick Fix
mode to open the Creation
Setup window.
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We cover each option available in the various wizard windows in greater
detail in Chapter 16.

Using the Photo Bin
The Photo Bin displays thumbnail views of all your open images. Regardless
of whether you work in Full Edit or Quick Fix mode, you can immediately see
a small image of all the pictures you have open at one time, as shown in
Figure 1-12. You can also see thumbnail views of all the different views you
create for a single picture. Find out all the details in this section.

Figure 1-12: All open pictures and new views are displayed as thumbnails in the Photo Bin.

If you want to rearrange the thumbnails in the Photo Bin, just click and drag
horizontally to reorganize the order of the thumbnails.

Creating different views of an image
What? Different views of the same picture, you say? Yes, indeed. You might
create a new view when you want to zoom in on an area for some precise
editing and then want to switch back to a wider view. Here’s how you do it:

1. Click a thumbnail image in the Photo Bin.

The respective photo appears in the image window as the active 
document.

2. Choose View➪New Window for <filename>.

Note that <filename> is the name of the file in the image window.

3. Zoom to the new view.

A new view appears for the active document, and you see another
thumbnail image added to the Photo Bin.

05_098103 ch01.qxp  12/8/06  11:14 PM  Page 22



To zoom quickly, click the Zoom tool and click a few times on the picture
in the image window to zoom into the photo.

4. Toggle views of the same image.

Click one thumbnail and you see the opening view; click the other
thumbnail and you see the zoomed view.

Hiding the Photo Bin
The Photo Bin takes up a lot of room at the bottom of the image window, and
you’re not likely to want it open all the time while editing some pictures.
Fortunately, Elements provides you with two methods for hiding the Photo
Bin when you want to create a little more editing real estate.

To temporarily hide the Photo Bin, do one of the following:

� Place the cursor over the separator bar between the Image window and
the Photo Bin. When the cursor changes to two horizontal lines with 
vertical opposing arrowheads, drag down to collapse the Photo Bin.
When the bin is collapsed, drag up the separator bar to open the bin.

� To auto-hide the Photo Bin, open a context menu (right-click inside the
Photo Bin) and select Auto-hide from the menu choices. (Alternatively,
you can just click the separator bar where you see the tiny arrowhead to
show or hide the bin.) When you use Auto-hide, the Photo Bin automati-
cally hides when the cursor appears in the image window. The Photo Bin
automatically opens when you move the cursor below the separator bar.

Retracing Your Steps
Ever since Apple’s Macintosh brought a windows interface to the masses, the
Undo command has been one of the most frequently used menu commands
in every program developed. You make a change to your document, and if
you don’t like it, you simply choose Edit➪Undo or press the keyboard short-
cut Ctrl+Z/Ô+Z.

In Elements, your options to undo your work have expanded, as we explain in
this section.

Using the Undo History palette
Elements takes the Undo command to new levels by offering you a palette in
which all (well, almost all) your changes in an editing session are recorded
and available for undoing at any step in an editing sequence.

23Chapter 1: Getting to Know the Work Area
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Each edit you make is recorded in
the Undo History palette. To open
the palette, choose Window➪Undo
History. Make changes to your docu-
ment, and each step is recorded in
the palette, as you see in Figure 1-13.

If Elements slows down and you’re
moving along at a snail’s pace, open
the More drop-down menu in the
Undo History palette and choose
Clear Undo History. Elements flushes
all the recorded history and frees up
some precious memory that often
enables you to work faster.

We said almost all steps are recorded
because the number of steps the
History palette can record is con-
trolled by a preference setting that
tops out at 1,000 steps. If you choose Edit➪Preferences (Windows) or
Photoshop Elements Preferences (Mac) and look at the General preferences,
as we explain in more depth in Chapter 2, the number of history states (times
you can go back in history and undo) defaults to 50. You can change the
number to the maximum 1,000, if you like. But realize that the more history
states you record, the more memory that Elements requires.

To undo the last edit, you can use the keyboard shortcut Ctrl+Z/Ô+Z. When
you want to undo multiple edits, open the Undo History palette and click any
item listed in the palette. Elements takes you to that last edit while scrubbing
all edits that follow the selected item. If you want to bring back the edits, just
click again on any step appearing grayed out in the palette to redo up to that
level.

All your steps are listed in the Undo History palette as long as you remain in
Elements and don’t close the file. When the file is closed, all history informa-
tion is lost.

Reverting to the last save
As you work away in Elements, you should always plan on saving your work
regularly. Each time you save in an editing session, the Undo History palette
preserves the list of edits you made before the save and up to the maximum
number of history states defined in the General preferences.

Figure 1-13: The Undo History palette records
steps in an editing session.
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If you save, and then perform more edits, and then want to return to the last
saved version of your document, Elements provides you with a quick, effi-
cient way to do so. Choose Edit➪Revert, and Elements eliminates your new
edits and takes you back to the last time you saved your file.

When you choose Revert, the word Revert appears in the Undo History
palette. You can eliminate the Revert command from the Undo History
palette by right-clicking Revert in the Undo History palette and choosing
Delete from a context menu. This command returns you to the edits made
after the last save.

Getting a Helping Hand
You can reach for this book whenever you want some details about accom-
plishing a task while working in Elements. However, for those little annoying
moments, and just in case some coffee stains blot out a few pages in this
book, you may want to look for an alternative feature description from
another source.

Rather than accumulate a library of Elements books, all you need to do is look
at Elements itself to find some valuable help information quickly and easily. If
you’re stuck on understanding some feature, ample help documents that are a
mouse click away can help you overcome some frustrating moments.

Using Help
Your first stop for exploring the helpful information Elements provides 
is on the Help menu. There, you find several menu commands that offer 
information:

� Photoshop Elements Help: Choose Help➪Photoshop Elements Help or
press the F1 key to open the Elements Help file. You can type a search
topic and press Enter to open a list of items that provide helpful infor-
mation about the searched words.

For quick access to the Help document, type the text you want to search
into the text box on the right side of the menu bar in Full Edit or Quick
Fix mode.

� Glossary of Terms: As you read this book, if we use a term that you
don’t completely understand, open the Photoshop Elements glossary.
There, you find definitions of terms commonly used in photography and
image editing as well as terms related specifically to Elements.
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26 Part I: Getting Started 

� Tutorials: If you want to explore some advanced learning, check out the
online tutorials provided by Adobe Systems.

� Photoshop Elements Online: This menu command launches your
default Web browser and takes you to the Adobe Web site, where you
can find information about Elements, problems reported by users, and
some work-around methods for getting a job done.

Using PDFs from the installation CD
A number of bonus files are stored in PDF form on your installation CD. PDF
files require the free Adobe Reader program or one of the commercial
Acrobat viewers. Adobe Reader can be installed from the CD during the
installation process.

Depending on when you purchased your Elements installer CD, the version of
Adobe Reader on the CD may be outdated. If you want to stay with the latest
upgrade of Adobe Reader, open your Web browser and type this address on
the Location bar:

www.adobe.com/products/acrobat/readermain.html

Adobe Systems provides easy, step-by-step instructions for downloading the
most current, free Adobe Reader program and installing it on your computer.

Using ToolTips
As you move your cursor around tools and palettes, pause a moment before
clicking the mouse. A slight delay in your actions produces a ToolTip, as shown
in Figure 1-14. Elements provides this sort of dynamic help as you move the
cursor around the workspace and pause before moving to another location.

Figure 1-14: Place the cursor over a tool and pause a moment to open a ToolTip.

Using the How To palette
The default Palette Bin in Full Edit mode contains the How To palette at the
top of the bin. The How To palette lists some of the more common tasks
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you’re likely to perform in Elements. Click the right-pointing arrowhead to
expand a list, and then click an item to open help information in the palette.
You can scroll pages by clicking the arrows, return to the opening How To
page by clicking the house icon, and print a topic by clicking the printer icon
if you want to create hard copy of some help information.

Taking Charge with Shortcuts
As Emeril says, “It’s time to kick it up a notch.” Kicking it up a notch in
Elements terms means leaving the pick-and-poke editing method of the
novice and graduating to techniques used by the swift keyboard master.

Using keyboard shortcuts greatly reduces your time in Elements and makes
you much more proficient. The upside is that most of what you can do by
moving the mouse and clicking a tool or menu command can be performed
right from your keyboard by using combinations of keystrokes. The downside
is that, because Elements has so many keyboard shortcuts, remembering all
of them is nearly impossible.

The best way to remember keyboard shortcuts is to practice using them.
After that, you may want to browse the resources where shortcuts are
defined. Here are some considerations to help you remember shortcuts and
find more information about them:

� For common tasks, always take special note of ToolTips and com-
mands on a menu. ToolTips provide descriptions of what tools do and
often display the keyboard shortcuts used to access the tools. Menu
commands that support keyboard shortcuts list the shortcut keys to
the right of command names.

� Look over all the tips and alternative methods for performing an
action that we describe throughout this book. As you’re introduced to
more features in Elements, we try to offer you the keyboard shortcut
options as well as tools and commands. Rather than give you a list here,
we provide keyboard shortcuts when we explain features.

� Search the Help document. Open the Elements Help document
(choose Help➪Photoshop Elements Help or press F1) and search for
keyboard shortcuts. The Help document provides a comprehensive
list of all the keyboard shortcuts you can use in Elements.

� Stick with the essentials. Try to commit to memory only those short-
cuts that produce actions for your most common editing tasks.

The Cheat Sheet at the front of this book lists some common keyboard short-
cuts so that you can reference them quickly and easily.
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Memorizing keyboard shortcuts isn’t critical to your work in Photoshop
Elements. You can do everything the program was designed for without
ever using a shortcut. However, when you become familiar with keyboard
shortcuts, you’ll zoom through editing sessions with much more speed and
efficiency. As a matter of fact, many advanced and professional users often
forget where a menu command is contained because they rely so much on
shortcut keys.
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